Experiment HP-5: Facial Electromyograms (EMG) and Emotion
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Facial Electromyography (fEMG) refers to an EMG technique that measures muscle activity by
detecting the electrical impulses that are generated by muscle fibers in the face when they contract. It
primarily focuses on two major muscle groups, the corrugator supercilli and zygomaticus major muscle
groups.
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Facial EMG has been studied to assess its basis as a tool for measuring emotional reactions to various
stimuli. Studies have found that contraction of the corrugator muscle, which lowers the eyebrow and is
involved in frowning, varies inversely with the activity of the zygomaticus muscle, which controls
smiling. It is said these muscle groups are either associated with negative emotional stimuli and
negative mood (corrugator) or positive emotional stimuli and positive mood (zygomaticus). Facial
Electromyography is emerging as a more precise and sensitive method to measure changes in facial
expressions than just using visual observation. Facial EMG measures minute changes in the electrical
activity of facial muscles, which reflects minute muscle movements. This technique has been shown to
be capable of measuring facial muscle activity to even weakly evocative emotional stimuli. Even when
subjects are instructed to inhibit their emotional expression, facial EMG can still register the response.
Facial EMG has been used to distinguish and track positive and negative emotional reactions to a
stimulus as it occurs. Many of these experiments have been conducted in laboratory environments
using a range of stimuli, such as: still pictures, movie clips and music pieces.
Another aspect of Facial EMG is the different emotional responses shown between males and females.
Analysis in a number of experiments has shown that compared to men, women reported higher feelings
of pleasantness and generated significantly higher EMG ratios at the zygomatic muscle region while
viewing pleasant images and women reported significantly fewer feelings of pleasantness and
generated significantly higher EMG ratios at the corrugator muscle region while viewing unpleasant
images. These results have demonstrated that gender plays a role in emotion expression and associated
EMG responses while viewing emotion provoking photographs.
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In this series of lab exercises, students will record and analyze facial EMGs using an iWorx A/D
recorder while looking at a variety of images known to produce emotional responses. Students will be
viewing still images, but this exercise can be extended to include both video and responses when
listening to music. This lab experiment is also fully customizable to add Galvanic Skin Response to the
data collection. This will allow students to observe a wider range of parameters to support the idea that
facial EMGs are a valid method for determining emotional response.
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Experiment HP-5: Facial Electromyograms (EMG) and Emotion
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Equipment Required
PC or Mac Computer
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USB cable
IX-B3G recorder
Five EMG electrode lead wires
Disposable electrodes

Optional Equipment:
IX-B3G GSR electrodes

IX-B3G Setup
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Alcohol swabs

Use the USB cable to connect the computer to the USB port on the IX-B3G.
Start the Software

1. Click on the LabScribe shortcut on the computer’s desktop to open the program. If a shortcut is
not available, click on the Windows Start menu, move the cursor to All Programs and then to
the listing for iWorx. Select LabScribe from the iWorx submenu. The LabScribe Main window
will appear as the program opens.
2. On the Main window, pull down the Settings menu and select Load Group.
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3. Locate the folder that contains the settings group, IXB3G.iwxgrp. Select this group and click
Open.
4. Pull down the Settings menu again. Select the FacialEMG settings file from Human
Psychophysiology.
5. After a short time, LabScribe will appear on the computer screen as configured by the
FacialEMG settings.
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6. For your information, the settings used to configure the LabScribe software and the IX-B3G
unit for this experiment are programmed on the Preferences Dialog window which can be
viewed by selecting Preferences from the Edit menu on the LabScribe Main window.
7. Once the settings file has been loaded, click the Experiment button on the toolbar to open any
of the following documents:
•
•
•
•

Appendix
Background
Labs
Setup (opens automatically)
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Note: If you choose to add the Optional GSR Channel as listed above, use the Edit, Preferences dialog
window and follow the directions later in the lab.
EMG Cable Setup
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1. Locate the red, black, green, brown, and white electrode lead wires and connect them to the
color coded sockets on the IX-B3G (Figure HP-5-S1).

2. Locate the muscles of the face over which the recording electrodes will be placed. Muscles can
be located by frowning and smiling and noting the areas of the face where the muscles are
tense.
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3. Use an alcohol swab to clean and scrub the areas where the electrodes will be placed. Let the
areas dry before attaching the electrodes.
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Figure HP-5-S1: The IX-B3G with EMG lead wires and electrodes connected.

Note: You will need to trim the snap electrodes carefully so they fit close together in each of the
locations. Trim them prior to removing the plastic backing.
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4. Remove the plastic disk from a disposable electrode and apply it to one of the scrubbed areas.
Attach an electrode to each of the other areas.
5. One pair of recording electrodes will be placed over the Corrugator supercilli muscle just above
the left eyebrow.
•

The first electrode is placed above the eyebrow and directly in line with inside corner of
the eye. This sensor should be placed as close to the eyebrow as possible.

•

The second sensor is placed directly next to the first sensor and to the outside of the eye.

7. The second pair of recording electrodes will be placed along the Zygomaticus major muscle
along the right cheek.
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Trace an imaginary line between the corner of the mouth and the indentation at the top
of the ear. Place the first electrode directly in the center of this imaginary line.

•

Place the second electrode immediately next to the first, closer to mouth along the
imaginary line.
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•
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8. The fifth electrode, used as the ground, is centered on the subject’s forehead.

Figure HP-5-S2: The positions of the electrodes on the face for recording Facial EMGs.
9. The positions of the electrodes are as follows (Figure HP-5-S2)

The red “+1” lead is placed near the center of the left eyebrow.

•

The black “-1” lead is placed immediately to the left of the red electrode towards the
outside of the eyebrow.

•

The brown “+2” lead is placed along the cheek midway between the ear and the mouth.

•

The white “-2” lead is placed adjacent to the brown electrode closer to the mouth.

•

The green “G” electrode is placed in the center of the forehead.
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•
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Note: The electrodes must be placed very close together, trimming them will help keep them
positioned correctly.
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Exercise 1: Muscles in Face used for Smiling and Frowning
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Aim: To study the EMG activity in muscles of the face that work to smile or frown.

Procedure

1. Instruct the subject that he or she will be doing the following during this exercise:

Before the recording begins, the subject will sit quietly with their mouth neither smiling
nor frowning. This position is defined as the neutral position.

•

Smile widely away from the neutral position and hold this position for four seconds
(Figure HP-5-L1).
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Figure HM-9-L1: Movement performed while recording from muscles of the face responsible smiling.
Note that the top channel (Corrugator s.) is not active while the subject is smiling.
•

Frown and mouth to the neutral position for at least wo seconds.
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•

Return the mouth to the neutral position for four seconds.

•

Repeat this cycle two more times while recording.

2. Before the starting the recording, type Neutral in the Mark box to the right of the Mark button.
Instruct the subject to place his or her mouth in the neutral position.
3. Click the Record button in the upper right corner of the LabScribe Main window. Click on the
Mark button to label the recording.
4. While the subject’s mouth is in the neutral position, type Smile in the Mark box. When the
subject smiles, click on the Mark button to label the recording.
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5. While the subject is smiling, type Neutral in the Mark box. When the subject returns his or her
mouth to the neutral position, click on the Mark button to label the recording.
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6. While the subject’s mouth is in the neutral position, type Frown in the Mark box. When the
subject frowns, click on the Mark button to label the recording.
8. When the last cycle is completed, click the Stop button.
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7. Repeat Steps 2 through 6 two more times.
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9. Click AutoScale on all channels to amplify signals. The recording should be similar to Figure
HP-5-L2.
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Figure HP-5-L2: Recording showing the movements when the subject is smiling and frowning.
10. Select Save As in the File menu, type a name for the file. Choose a destination on the computer
in which to save the file, like your lab group folder. Designate the file type as *.iwxdata. Click
on the Save button to save the data file.
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Data Analysis

1. Scroll through the recording and find the section of data recorded while the subject was smiling
and frowning.
2. Use the Display Time icons to adjust the Display Time of the Main window so three smilefrown cycles appear on the Main window. The three cycles can also be selected by:
•

Placing the cursors on either side of the three adjacent cycles; and

•

Clicking the Zoom between Cursors button on the LabScribe toolbar to expand the
segment with the three cycles to the width of the Main window.
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3. Click on the Analysis window icon in the LabScribe toolbar (Figure HP-5-L3) or select
Analysis from the Windows menu to transfer the data displayed in the Main window to the
Analysis window (Figure HP-5-L4).

am
ple

Figure HP-5-L3: The LabScribe toolbar.
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4. Look at the Function Table that is above the uppermost channel displayed in the Analysis
window. The mathematical functions, Abs. Int and T2-T1, should appear in this table. The
values for Abs. Int and T2-T1 on each channel are seen in the table across the top margin of
each channel.

Figure HP-5-L4: EMG activity from the muscles used for smiling and frowning. Cursors are placed to
measure the EMG activity taking place during the first “smile” episode.
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5. Once the cursors are placed in the correct positions for measuring the parameters of a smile or
frown, the values for the parameters can be recorded in the on-line notebook of LabScribe by
typing the names and values directly into the Journal, or on a data table.
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6. The functions in the channel pull-down menus of the Analysis window can also be used to enter
the names and values of the parameters to the Journal. To use these functions:
Place the cursors at the locations used to measure the absolute areas.

•

Transfer the name of the mathematical function used to determine the absolute areas to
the Journal using the Add Title to Journal function in the Zygomaticus major m. Channel
pull-down menu.

•

Transfer the values for the absolute areas to the Journal using the Add All Data to
Journal function in the Zygomaticus major m. Channel pull-down menu.
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7. Use the mouse to click on and drag the cursors to the onset and offset of the first smile (Figure
HP-5-L4). The values for Abs. Int and T2-T1 on the Zygomaticus major channel are the relative
amounts of the EMG activity and the durations of the zygomaticus muscle during the smile.
8. Use the mouse to click on and drag the cursors to the onset and offset of the first frown. The
values for Abs. Int and T2-T1 on the Corrugator supercilli channel are the relative amounts of
the EMG activity and the durations of the corrugator muscle during the frown.
•

The values for these parameters, listed in the table above the Corrugator supercilli
channel, are the same properties from the corrugator muscle during the frown.

9. Record the values from each muscle during the first smile frown in the Journal, or on a data
table.
10. Use the mouse to move the cursors to onset and offset of the next smile. Measure and record the
values for Abs. Int and T2-T1.
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11. Use the mouse to move the cursors to onset and offset of the next frown. Measure and record
the values for Abs. Int and T2-T1.
12. Repeat steps 10 and 11 for the last smile-frown recording.
13. Average the values for each parameter taken from the zygomaticus muscle during smiling. Find
the average for each parameter from the corrugator muscle during frowning. Enter the averages
for each parameter on Table HP-5-L1.
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14. Select Save from the File menu.

Questions

1. Which muscle had the most EMG activity during smiling?
2. Which muscle had the most EMG activity during frowning?
3. Did the subject notice the way the muscles moved during smiling and frowning. If so, what can
be commented upon about how these muscles move to accommodate smiling and frowning?
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Table HP-5-L1: Average EMG Activity and Duration during Smiling and Frowning
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Smile
Smile
Frown
Frown
Abs Int (mV) Time (sec) Abs Int (mV) Time (sec)
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1
2
3
Mean
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Exercise 2: Smiling and Frowning While Looking at a Variety of Images

Aim: To study the subject’s emotional response while looking at a series of images.
Procedure

1. Instruct the subject that he or she will be doing the following during this exercise:
•

Before the recording begins, the subject will sit quietly with their mouth neither smiling
nor frowning. This position is defined as the neutral position.

•

The subject will then be shown an emotional or neutral image for a few seconds.

•

Based on the emotion felt while looking at the image - the subject will smile, frown or
leave the mouth in the neutral position.
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Note: It is important to have on hand a variety of images that express happiness, sadness, excitement,
surprise, agony, etc... for the subject to view during this portion of the experiment. Neutral images,
such as a single color or a blank page, will also be used.
2. Click the Record button in the upper right corner of the LabScribe Main window.
3. While the subject is sitting quietly, begin to show the images one at a time. Pause on each image
for 3-5 seconds to allow the subject to respond to what he or she is looking at.
4. Mark the recording with either an S, F or N based on the type of image shown. Click on the
Mark button to label the recording appropriately.
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5. Repeat step 4 using at least 20 images that will elicit some sort or emotional or neutral response.
6. Select Save from the File menu.

Data Analysis

1. Scroll through the recording and find the beginning of the section of data recorded while the
subject was looking at the images.
2. Click and drag the cursors so they are placed at the onset and offset of the response to the
image.
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3. Click on the Analysis window icon in the LabScribe toolbar or select Analysis from the
Windows menu to transfer the data displayed in the Main window to the Analysis window.
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4. Look at the Function Table that is above the uppermost channel displayed in the Analysis
window. The mathematical functions, Abs. Int and T2-T1, should appear in this table. The
values for Abs. Int and T2-T1 on each channel are seen in the table across the top margin of
each channel.
5. Measure the Abs. Int and T2-T1 value for the response to the image shown and record the
values in either the Journal or on Table HP-5-L2.
6. If there is no response, leave the value columns empty.

Questions
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7. Scroll through the recording and repeat steps 5 and 6 for all 20 images shown.

1. Did the subject show the expected emotional response to each of the image shown?
2. If the subject did not shown the expected response, what explanation can be given for this?
3. Was there any variation in EMG activity or duration of the response based on the image? Why
could this happen?
4. What reasons can you give for a lengthier response?
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5. What reasons can you give for a higher or lower EMG response?
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Table HP-5-L2: Recorded Values for Emotional Images
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Image Type (S, F, or N)

Frown
Smile
Smile
Frown
Abs Int (mV)
Abs Int (mV) Time (sec)
Time (sec)

MEAN
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Additional Transducer Setup for Advanced Data Collection
This lab is fully expandable to record not only EMG activity, but also GSR response.
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GSR Setup
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To record the GSR response, follow the directions below.

1. Locate the orange and purple GSR electrodes and connect them to the color coded sockets on
the IX-B3G.
2. Click Edit, Preferences to open the Preferences dialog window.

Place a check in the box labeled GSR-Skin Conductance or in the GSR channel.

•

Click OK.

Calibration of GSR Amplifier
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1. Record data for 1 minute.
2. Click on the Stop button.
3. Set the baseline to zero:

Click the down arrow to the left of the GSR channel to open the Channel Menu.

•

Click Units

•

Click Set Offset (Figure HP-5- L6)

•

Set the offset to 0 and check Apply to all blocks

•

Click OK.
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Figure HP-5-L6: Apply Offset window for setting the GSR unit to “0”.
Note: The GSR-200 galvanic skin response amplifier is factory calibrated so that an output of 1 Volt is
equal to 1 microSiemens (µS).
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4. To check the programming of the calibration:
Click on the arrow next to the title of the Skin Conductance Level channel to open the
channel menu.

•

Select Units from the channel menu and Simple from the Units submenu.

•

The Simple Units Calibration window will appear with the values for the two-point
calibration already entered.

Exercise 3: Tonic SCL and Habituation

La

b

•

Aim: To measure the subject’s tonic skin conductance level and observe possible spontaneous skin
responses.
Procedure
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1. Select one person from your group to be the subject. Ask the subject to go to the sink, wash his
or her hands with soap and water, and dry them thoroughly. Washing the hands insures that
surface oils or other substances, which might lower skin conduction, are removed. Do not use
alcohol to clean the fingers, alcohol dehydrates the skin.
2. The subject should sit with his or her back to the computer monitor. Use the subject’s hand
which is closer to the iWorx equipment.
3. Attach each GSR electrode to the volar surface of the distal finger segment of two non-adjacent
fingers; the index and the ring fingers are the ones usually used. Attach the electrodes with the
Velcro straps so that the straps are snug, but not overly tight.
4. The subject should rest his or her hand with the GSR electrodes comfortably. The GSR
electrodes should be free from any extraneous pressure and the electrode cable should be
hanging freely. Instruct the subject not to move the hand during the recording process;
movement will introduce artifacts into the recording.
•

Tonic Skin Conductance Level: In this measurement, the subject sits quietly for one
minute as his or her tonic skin conductance level (SCL) is recorded. Any movement may
cause an artifact in the recording.
Habituation: In this measurement, the subject’s tonic skin conductance level (SCL) is
recorded as he or she sits quietly and without movement. While recording the subject’s
SCL, ask the subject the question: Is your name, X? (where X is the subject’s real name).
The subject should respond: Yes. After the subject’s SCL changes and then returns to the
baseline, ask the subject the same question. Continue to ask this same question until the
subject shows no response on three consecutive trials. Lack of a change in the subject’s
SCL while answering the question is considered habituation.
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5. Two measurements are performed in this exercise:

6. Type First Tonic SCL <Subject’s Name> in the Mark box that is to the right of the Mark button.
7. Click on the Record button. Press the Enter key on the keyboard. Since the GSR amplifier was
zeroed in the Calibration section of this exercise, the value displayed on the Skin Conductance
Level channel is the tonic skin conductance level (SCL) of the subject (Figure HP-5-L8). This
value should be between 2 and 20 µSiemens. Record the subject’s tonic SCL for one minute.
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Figure HP-5-L8: The output of the GSR amplifier before and after the GSR electrodes, which are
already on the fingers of the subject, were connected to the amplifier. The difference between the output
of the amplifier before and after the connection of the electrodes is the tonic skin conductance level of
the subject, which is 0.394 microSiemens (µS).
8. After recording the subject’s tonic SCL, use the Offset Directions above to adjust baseline of
the recording to zero.
9. Type Baseline <Subject’s Name> in the Mark box and press the Enter key on the keyboard.
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10. Type Is Your Name, <Subject’s Name>? in the Mark box Press the Enter key on the keyboard as
the subject is asked the question. Continue recording.
11. Type IYNX (Is Your Name, X?) in the Mark box. When the subject’s tonic skin conductance
level is response to the previous question has returned to the baseline, press the Enter key on the
keyboard and ask the question again.
12. Repeat Step 11 until the subject shows no response to the question for three consecutive times.
Click Stop to halt the recording.
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13. Select Save As in the File menu, type a name for the file. Choose a destination on the computer
in which to save the file, like your lab group folder).
14. Designate the file type as *.iwxdata. Click on the Save button to save the data file.
15. Repeat this exercise on other subjects in your lab group.

Data Analysis - Tonic Skin Conductance Level
1. Scroll through the data file and locate the recording of the subject’s tonic skin conductance level
(SCL).
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2. Use the Display Time icons to adjust the Display Time of the Main window to display the one
minute recording of the subject’s tonic SCL on the Main window. This section of data can also
be selected by:
Placing the cursors on either side of the one minute recording of the subject’s SCL, and

•

Clicking the Zoom between Cursors button on the LabScribe toolbar (Figure HP-5-L9)
to expand or contract the one minute recording to the width of the Main window.
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3. Click on the Analysis window icon in the toolbar or select Analysis from the Windows menu to
transfer the data displayed in the Main window to the Analysis window.

Figure HP-5-L9: The LabScribe toolbar.

4. Look at the Function Table that is above the Skin Conductance Level channel in the Analysis
window. The mathematical function, Mean, should appear in this table. The value for mean
tonic skin conductance level is displayed in the table across the top margin of the Skin
Conductance Level channel.
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5. Once the cursors are placed in the correct positions for determining the mean tonic skin
conductance level in the one minute recording, the value for the mean tonic skin conductance
level can be recorded in the on-line notebook of LabScribe by typing the name and value of the
parameter directly into the Journal.
6. The functions in the channel menu of the Analysis window can also be used to enter the names
and values of the parameters from the recording to the Journal. To use these functions:
•

Transfer the name of the parameter to the Journal using the Add Title to Journal function
in the Skin Conductance Level channel menu.
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•

Place the cursors at the locations used to measure the mean tonic skin conductance level.

•

Transfer the value for the mean to the Journal using the Add Ch. Data to Journal
function in the Skin Conductance Level channel menu.

7. On the Skin Conductance Level channel, use the mouse to click on and drag a cursor to the left
margin of the data displayed on the Analysis window. Drag the other cursor to the right margin
of the same data.
8. Record the values in the Journal using the one of the techniques described in Steps 5 or 6.
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9. Enter the value for the mean tonic skin conductance level for the subject in Table HP-5-L3.
Data Analysis - Spontaneous Skin Conductance Responses
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1. On the one minute recording of the subject’s tonic skin conductance level displayed in the
Analysis window, count the number of spontaneous skin conductance responses that occurred
during the one minute recording of the subject’s tonic skin conductance.

Note: Changes in the subject’s skin conduction level (SCL) which are upward deflections equal to or
greater than 0.05 µS are counted as spontaneous skin conduction responses. The SCL does not need to
return to the baseline value before another response takes place.
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2. Enter the number of spontaneous skin conductance responses that occurred in the one minute
recording in the Journal by typing the value directly into that window.
3. Enter the number of spontaneous skin conductance responses per minute for the subject in Table
HP-5-L3.
Data Analysis - Habituation

1. Click on the Main window icon to return to viewing the data on the Main window. Scroll
through the data file and locate the recording of the habituation SCL for the subject.
2. Use the Display Time icons to adjust the Display Time of the Main window to display the
complete habituation period on the Main window.
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3. Determine the subject’s habituation score by counting the number of times the question, Is your
name, <Subject’s Name>? was asked before the habituation criterion was reached. Each time
the question is asked is considered a trial. The habituation criterion is reached when there is no
skin conductance response from the subject for three consecutive trials. For example, if the
subject first shows no skin conductance response to the question in the sixth trial, and no
responses in the seventh and eighth trials, the subject’s habituation score is six. Typical
habituation scores are between two and eight.
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Note: Some spontaneous skin responses may occur during the habituation test. Do not count
spontaneous responses in the habituation score. Only count a trial as a skin conductance response to
the question when the response begins within three seconds of the question and the skin conductance
change is equal to or greater than 0.05 µS.
4. Enter the subject’s habituation score in the Journal by typing the value directly into that
window.
5. Enter the subject’s habituation score in the table.
6. Enter the value for the tonic skin conductance level, the number of spontaneous skin responses
per minute, and the habituation score for all the subjects in your group into the table. The class
data will be used in Exercise 7.
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Table HP-5-L3:Tonic SCL, Spontaneous Skin Responses and Habituation
Habituation Score
(Trials before
Habituation)
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Spontaneous Skin Responses
(Number/Minute)
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Subject

Mean Tonic SCL
(µS)

Exercise 4: Skin Conductance Levels While Looking at a Variety of Images

Aim: To determine the change in the skin conductance level and the peak response rise time of a
subject responding to a series of images.
Note: This exercise should be completed in conjunction with the EMG exercise where the subject is
looking at a variety of images. This will allow you to see the skin conductance change in accordance
with a response to these images while the subject is also smiling, frowning or having no reaction.
Procedure

1. The same subject that performed Exercise 1 should participate in this exercise.
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2. The subject will be shown a series of 20 images with an emotional or neutral content. Instruct
the subject to sit quietly and respond to these images normally.
3. Click the Record button in the upper right corner of the LabScribe Main window.
4. While the subject is sitting quietly, begin to show the images one at a time. Pause on each image
for 3-5 seconds to allow the subject to respond to what he or she is looking at.
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5. Mark the recording with either an S, F or N based on the type of image shown. Click on the
Mark button to label the recording appropriately.
6. Wait for the subject’s skin conductance level to return to the baseline level before showing the
next image.
7. Repeat Steps 5 and 6 for the remaining 19 images.
8. Click Stop to halt the recording.
9. Select Save in the File menu.
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Data Analysis
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1. Scroll through the data file and locate the recording of the subject’s skin conductance response
to the first image.

La

2. Use the Display Time icons to adjust the Display Time of the Main window to display the
complete response to the first question on the Main window. This section of data can also be
selected by:
•

Placing the cursors on either side of the subject’s skin conductance response to the first
question, and

•

Clicking the Zoom between Cursors button on the LabScribe toolbar to expand or
contract this section of the recording to the width of the Main window.
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3. Click on the Analysis window icon in the toolbar or select Analysis from the Windows menu to
transfer the data displayed in the Main window to the Analysis window.
4. Look at the Function Table that is shown in the Analysis window.
•

Click Add Function, General to add the following functions to the list available: Value1,
Value 2, V2-V1. Each function will need to be added individually.

•

Once the functions have been added, Abs Int, T2-T1, Value1, Value 2, and V2-V1 should
appear in this table. The values for these functions are displayed in the table across the
top margin of the Analysis window.

5. On the Skin Conductance Level channel, use the mouse to click on and drag a cursor to the
point in the recording when the image was shown and an EMG response was seen. Drag the
other cursor to peak of the subject’s response to the image. The following parameters of the
subject’s response are measured by the functions listed in the table:

•

Peak Response Skin Conductance Level, which is the maximum skin conductance level
of the subject in the period after the question was asked. The value for the Value2
function on the Skin Conductance Level channel is the skin conductance level of the
peak response of the subject.
Change (Δ) in Skin Conductance Level, which is the difference between the baseline and
maximum skin conductance levels of the subject in response to the question. The value
for the V2-V1 function on the Skin Conductance Level channel is the change in the skin
conductance level of the subject.

iW
or

•

Baseline Skin Conductance Level, which is the skin conductance level of the subject at
the time the question was asked. The value for the Value1 function on the Skin
Conductance Level channel is the baseline skin conductance level.

xS

•

•

Peak Response Rise Time, which is the time between the question being asked and the
peak response of the subject to the question. The value for the T2-T1 function on the
Skin Conductance Level channel is the rise time of the peak response.

6. Record the values for these functions in the Journal using the one of the techniques described in
Exercise 1.
7. Enter the values for the baseline skin conductance level, peak response SCL, change in SCL,
and rise time of the peak response for the first question in Table HP-5-L4.
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8. Repeat Steps 1 through 7 for the other 19 images.
Questions

b

1. Did the subject show any changes in skin conductance during the different images shown?

La

2. How does skin conductance relate to looking at image that produce either a positive (smiling) or
negative (frowning) response? Is there a difference in the type of response seen?
3. Does the subject take longer to respond to a negative or positive image? Explain your answer.
Table HP-5-L4: Skin Conductance Changes for a Variety of Images
Baseline SCL
(µS)

Peak
Response
SCL (µS)

Δ in SCL
(µS)

Peak Response Rise Time
(seconds)

iW
or

xS

am
ple

Images (S, F, or
N)
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